
1606, v2.2, 2025-11-07

®

NPX™ Signature
Software User Manual



Part 1: Table of contents

Part 1: Introduction
1. About this manual.....................................................................................................................................4

1.1	 Intended use..................................................................................................................................4
1.2	 Intended target group...............................................................................................................4
1.3	 Definition of alert levels............................................................................................................4

2. List of abbreviations................................................................................................................................5

3. Associated documentation....................................................................................................................5

4. Technical support......................................................................................................................................5
4.1	 Log files...........................................................................................................................................5

5. Software and file requirements...........................................................................................................6

6. Installation...................................................................................................................................................6
6.1	 License agreement......................................................................................................................6
6.2	 Install software.............................................................................................................................6
6.3	 Uninstall software.......................................................................................................................6

Part 2: Technology description
7. Overview........................................................................................................................................................ 7

8. Normalization methods..........................................................................................................................8
8.1	 Plate control normalization....................................................................................................8
8.2	 Calibrator normalization (Olink® Target 48, Olink® Flex, and Olink® Focus).....9
8.3	 IPC normalization (Olink® Target 96).............................................................................. 10
8.4	 Intensity normalization (Olink® Target 96)................................................................... 10
8.5	 CV calculation.............................................................................................................................11
8.6	 Sample QC....................................................................................................................................11
8.7	 Assay QC...................................................................................................................................... 12
8.8	 Run QC...........................................................................................................................................13
8.9	 QC criteria.................................................................................................................................... 14

Part 3: Operation
9. Introduction...............................................................................................................................................15

10. Files and information needed for analysis................................................................................ 16
10.1	Panel Data Files and Panel Data Archive....................................................................... 16
10.2	Olink® Signature Q100 Run Data.......................................................................................17
10.3	Sample Manifest file.................................................................................................................17
10.4	NPX™ Signature Study File (.npx)..................................................................................... 18

11. Operating workflow............................................................................................................................ 19
11.1	 Download Panel Data Files or Panel Data Archive .................................................... 19
11.2	Import Panel Data Files or Panel Data Archive............................................................ 19
11.3	Create a new project .............................................................................................................. 21
11.4	Import a split Olink® Target 48 in version 2.x............................................................... 25
11.5	Migration of NPX™ Signature Software v1.x projects..............................................26
11.6	Migrate a project......................................................................................................................26
11.7	 Migration information............................................................................................................ 27
11.8	Perform quality control..........................................................................................................28
11.9	Export result files...................................................................................................................... 29

12. Result files................................................................................................................................................31

2



12.1	CSV files.........................................................................................................................................31
12.2	Analysis Report......................................................................................................................... 34

Part 4: User Interface
13. General..................................................................................................................................................... 36

13.1	 Plate Selection........................................................................................................................... 37
13.2	Options menu............................................................................................................................. 37
13.3	Project Actions menu.............................................................................................................. 38

14. Views ........................................................................................................................................................ 39
14.1	Project...........................................................................................................................................40
14.2	Metrics..........................................................................................................................................42
14.3	Plate Details................................................................................................................................ 43
14.4	QC Summary............................................................................................................................... 45
14.5	Sample QC...................................................................................................................................46
14.6	Plate Data....................................................................................................................................48
14.7	Workspace...................................................................................................................................49
14.8	Amplification Curves...............................................................................................................50
14.9	Heat Map......................................................................................................................................51
14.10 Detectability............................................................................................................................. 53
14.11 Plate Variation......................................................................................................................... 54
14.12 History......................................................................................................................................... 55

15. Keyboard shortcuts............................................................................................................................. 56

Part 5: Troubleshooting
16. Introduction............................................................................................................................................57

16.1	Warning messages....................................................................................................................57

17. Deviating controls................................................................................................................................ 59

18. Sample warned by Detection Control......................................................................................... 61

19. Inconsistent results detected..........................................................................................................64

20. Revision history.................................................................................................................................... 70

3



4

Part 1: Introduction

1. About this manual
This user manual provides you with the instructions needed for processing the raw data and performing 
quality control on the data from Olink® panels with the NPX™ Signature Software version 2.2 and later. For 
user manual for NPX Signature Software v1.x, please contact support@olink.com.

The NPX Signature Software is a standalone Windows® software application that enables qualification 
and normalization of Olink mid and low plex data, which can be used in further downstream analysis 
revealing protein discoveries and signatures. The software enables this through data normalization in NPX, 
quantitative data and a fit-for purpose quality controls together with result exports. 

1.1	 Intended use
The NPX Signature Software is a data analysis software that is designed to use with the qPCR-based kits 
from Olink, including Olink® Target 48, Olink® Target 96, Olink® Focus as well as for Olink® Flex panels. It 
allows for importing run data, validating data quality, and normalizing Olink data for subsequent statistical 
analysis.

The kits can be used with the Olink® Signature Q100 qPCR device. NPX Signature Software lets you import 
data from Olink Signature Q100, validate its quality, and normalize it. The data is not required to be 
annotated or processed before importing it into the NPX Signature software. The software can also process 
Fluidigm® Biomark™ data after annotation. 

NPX™ Signatureraw data Ct Insight Olink Analyze 
and R package

Outout Ct, NPX, absQuant
Olink Signature Q100

device qPCR
Panels

This product is for Research Use Only. Not for use in diagnostic procedures. 

1.2	 Intended target group
NPX Signature Software is intended to be used by trained users of the Olink® Target 48, Olink® Target 96, 
Olink® Focus, and Olink® Flex panels. Quality control should be performed by trained users that determine 
whether data from a run can be approved for further analysis.

1.3	 Definition of alert levels
The following alert levels are used in this user manual:

IMPORTANT:    Indicates an important action that may impair the results if not performed 
correctly.

NOTE:   Contains information that can make it easier to understand or perform a certain task.

NPX™ Signature Software User Manual 
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2. List of abbreviations
%CV Coefficient of Variation

IFC Integrated Fluidic Circuit (also called "chip" in this document)

IPC Inter-Plate Control

LLOQ Lower Limit of Quantification

LOD Limit of Detection

LOQ Limit of Quantification

LQL Lowest Quantifiable Level

MAD Median Absolute Deviation

NPX Normalized Protein eXpression

PCR Polymerase Chain Reaction 

QC Quality Control

ULOQ Upper Limit of Quantification

3. Associated documentation
Manuals
•	 Olink® Signature Q100 User Manual, doc no 1172

•	 Olink® Target 48 User Manual, doc no 1141 or 1553 

•	 Olink® Target 48 using Formulatrix F.A.S.T. User Manual, doc no 1414 or 2554

•	 Olink® Target 96 User Manual, doc no 0935 or 1546 

•	 Olink® Target 96 using Formulatrix F.A.S.T. User Manual, doc no 1415 or 1552

•	 Olink® Flex User Manual, doc no 1314 or 1555

•	 Olink® Flex using Formulatrix F.A.S.T. User Manual, doc no 1421 or 1556

•	 Olink® Focus User Manual, doc no 1231 or 1535

Documents with double document numbers refers to manuals with the old or the new version of PCR 
Polymerese.

White paper
•	 "Pre-analytical variation in protein biomarker research", doc no 1095

All relevant Olink documentation is available from the Olink website: olink.com/knowledge/documents.

4. Technical support
For questions, guidance, and support, contact Olink Proteomics at support@olink.com.

4.1	 Log files
The log file registers everything that happens in a project. When contacting the Olink Support, you might 
need to share the log files. They can be found on the local drive where NPX Signature was installed: 
%LocalAppData%\Olink\NPX-Signature\logs.

Do not move or in any other way manipulate the log files.

NPX™ Signature Software User Manual 
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5. Software and file requirements
Components Minimum Recommended

Operating System Windows® 11

Processor Intel® Core™ i5

Memory 16 GB RAM 32 GB RAM

Disk Space 500 MB

Display scale of computer screen Scale 100 % * 
14'' screen

* The scale resolution might affect different functions and features in the NPX Signature software, and different scale resolutions might be needed for 
different displays. Please, go to the computer settings to change to your preferred settings.

6. Installation

6.1	 License agreement
You are required to accept the end-user license agreement when installing the NPX Signature Software or 
before using an updated version for the first time.

6.2	 Install software
The installer performs a first-time installation or updates the existing installation if it is already installed on 
the local computer.

1.	 Download the latest version of NPX Signature Software to your computer from https://olink.com/
software/download. The password can be found in the release notes sent by email.

2.	 Double-click the installer (.msi) file.

3.	 Follow the on-screen instructions.

A desktop shortcut will be created for future use. To open the application, double-click on the icon. 

6.3	 Uninstall software
If you need to uninstall NPX Signature, use the Programs → Uninstall a program in the Control panel. 
Select NPX Signature from the program list and click Uninstall.

All user data is retained where it was saved before the application was uninstalled, and your custom NPX 
Signature Software settings are retained on the system. 

NPX™ Signature Software User Manual 
Part 1: Introduction 
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Part 2: Technology description

7. Overview
Olink has built-in quality controls in all multiplex panels. The internal controls allow for an in-process quality 
control designed to monitor different steps of the protocol: immuno reaction, extension and amplification/
detection. Each Olink panel also contains external controls that are added in triplicate or duplicate on each 
sample plate. 
For numbers of assays and controls for the different panels, please refer to the product specific user manual.

Immuno reaction Extension and 
pre-amplification

Amplification and
detection

Incubation control
Extension control

Detection control

•	 The Incubation Control(s) consists of a non-human antigen measured by specific PEA antibodies in the 
panel. This control monitors potential variation in all three steps of the reaction.

•	 The Extension Control is an antibody which contains two complementary DNA tags that are hence in 
close proximity. This control monitors the extension/pre-amplification and detection step and is used for 
normalization of the data.

•	 The Detection Control is a complete double stranded DNA amplicon which does not require any 
proximity binding or extension step. This control monitors the pre-amplification and detection step.

The Extension Control is used to calculate the NPX value, (refer to 8. Normalization methods) and the other 
two are used in Quality Control as described below.

Normalization, Quality Control and calculation of project summary metrics are run automatically in the NPX 
Signature Software and build on each other.

NPX™ Signature Software User Manual 
Part 2: Technology description 
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8. Normalization methods
The raw data from qPCR are Ct values. The Ct refers to the number of cycles required to cross the detection 
threshold of the PCR amplification curve. Based on Ct values, the arbitrary, relative quantification unit 
NPX™ is calculated.

8.1	 Plate control normalization
In this multi step normalization process, the protein expression values are normalized using the Extension 
Control, the plate control samples (Calibrators or IPCs) and a pre-determined correction factor. Each of 
these elements take a different source of potential run-to-run variation into account and reduce its effect.

Each sample is normalized with the Extension Control to reduce between sample variation:

dCtSample i, Assay j  = CtSample i, Assay j – CtSample i, Ext ctrl 

Each plate is normalized with the central value of its plate control samples (PCs) to reduce differences 
between runs within the same experiment and the pre-determined correction factor is used to limit 
technical differences between reagent batches:

NPXSample i, Assay j = Correction factorAssay j – 

(dCtSample i, Assay j – Central Value(PCAssay j))

The scale of the NPX unit is unique to each protein assay, meaning that even if two different proteins have 
the same NPX values, their concentrations in pg/mL may differ. It is not meaningful to compare NPX values 
between protein assays.

The correction factor is determined by Olink during the validation of the panels, and for each new reagent 

batch, a lot-specific correction factor is defined.

NPX™ Signature Software User Manual 
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8.2	 Calibrator normalization (  Olink® Target 48,  Olink® Flex, 
and  Olink® Focus)
For products with absolute quantification units, the plate control samples are Calibrators (refer to respective 
user manual). Calibrator normalization is performed as described in 8.1 Plate control normalization with the 
central value calculated for Olink® Target 48 and Olink® Flex as

Central Value(CalibratorAssay j) = median(Calibratori, Assay j)

While the central value in Olink® Focus is calculated as the mean over all median values per Calibrator type.

8.2.1	 Results in absolute quantification units (pg/mL)
For products that provide output in absolute quantification units, the NPX results from Calibrator 
normalization can be used to calculate results in standard units, for example pg/mL.

Before the run (during product development at Olink):

1.	 A correction factor, utilized to ensure accuracy between production batches, is calculated.

2.	 A precise pre-defined standard curve is established for each protein.

3.	 A four parameter logistic (4PL) model fit is performed to define the standard curve mathematically 
within the measurement range for each protein in the panel.

4.	 The lower and upper limits of quantification (LLOQ and ULOQ) are defined during the development of 
the panel, see the panel specific Validation data document available on the Olink website (www.olink.
com) for details. 

The illustration below shows an example of a standard curve.

Standard curves for each assay can be found via the panel product page on www.olink.com.

After each run:

1.	 Calibrator normalization is used to normalize the current run to the reference runs used to establish the 
4PL curve.

2.	 The standard curve model, is used to convert the measured NPX value to the protein concentration in 
pg/mL.

NPX™ Signature Software User Manual 
Part 2: Technology description 

8. Normalization methods

http://www.olink.com
http://www.olink.com
http://www.olink.com


10

8.3	 IPC normalization ( Olink® Target 96)
For Olink® Target 96 the plate control samples are IPCs (refer to the Olink® Target 96 User Manual). IPC 
normalization is performed as described in 8.1 Plate control normalization with the central value calculated 
as:

Central Value(IPCAssay j) = median(IPCi, Assay j)

8.4	 Intensity normalization ( Olink® Target 96)
In Intensity normalization the data is adjusted so that the median NPX for a protein on each plate is equal 
across all plates of an experiment. This method relies on the assumption that the true median of each 
plate is the same. One way of ensuring this, is to randomize the samples across plates. If there is total 
randomization, this method typically outperforms other normalization methods. If there are specific types 
of samples that are only available on certain plates, this normalization method should not be used.

Intensity normalization subtracts the central value of all samples (excluding the control strip) for each assay 
per plate:

iNPX Sample i, Assay j = NPX Sample i, Assay j – Central Value(NPX Assay j)

NOTE:  Internal Positive Controls (IPCs) are excluded from the normalization process when 
Intensity Normalization is applied. Despite this, IPCs remain part of the formal QC procedure, 
as they are included in the external controls provided with the Olink Target 96 kits. IPCs are 
expected to behave in a specific way. Deviations from expected behavior may indicate underlying 
issues with the run that are not apparent from customer sample data alone. When certain that the 
data is not affected, the warning can be ignored.

QC levels and possible status:

Datapoint Sample Assay Run

•	 Set by instrument

•	 Can be set to fail 
manually

•	 Set as part of automatic 
QC

•	 Can be set manually

•	 Set as part of automatic 
QC

•	 Can be set manually

•	 Set as part of automatic 
QC

•	 Status:
	– Pass
	– Flag/Fail

•	 Status other than Pass:
	– NA data

•	 Status:
	– Pass
	– Warning
	– Fail

•	 Warning:
	– Data shown and 
exported

•	 Fail:
	– Normalized data not 
shown or exported

•	 Status:
	– Pass
	– Warning
	– Fail
	– Undefined / NA

•	 Warning:
	– Data shown and 
exported

•	 Fail:
	– Normalized data not 
shown or exported

•	 Status:
	– Warning message

•	 No consequences for 
data presentation

NPX™ Signature Software User Manual 
Part 2: Technology description 
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8.5	 CV calculation
For evaluating the reproducibility and repeatability of data related to each plate in the project, as well as 
assessing the within- and between-plate variation in the project, two types of CV are calculated: within 
plate (intra CV) and between plates (inter CV) in Sample Controls. For the inter CV calculation, the mean of 
Sample Controls is used to represent the plate before CV calculation. These metrics are calculated for NPX 

and absolute quantification values using the following formulas: 

NPX  scale:

Absolute quantification scale:

8.6	 Sample QC
Each of the internal controls are spiked into all samples at a set concentration. The signals for these 
are therefore expected to be at comparable levels over the entire plate. Sample QC is performed using 
Detection Control and Incubation Control. If the observed value deviates more than 0.3 NPX from the plate 
wide median, or if the value is missing, the Sample QC is set to Warning. The Extension Control is used in the 
normalization step and in generation of NPX, and hence is not included in the Sample QC.

Deviating values for the internal controls can be caused by, for example, errors in pipetting or pre-analytical 
factors in the samples that affect the performance of the controls. For more information on troubleshooting 
samples that do not pass this QC, refer to 17. Deviating controls. 

NPX™ Signature Software User Manual 
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8.7	 Assay QC
Assay performance is assessed based on multiple criteria, taking into account availability of control data, 
variation of measured values and for certain products accuracy. Criteria checked against product specific 
reference values are listed in the table below. Recommended thresholds are shown in the software user 
interface.

Sample Control 
precision

 Olink Target 48

 Olink Flex

 Olink Focus

•	 Use data in NPX units

•	 Include all replicates that “Pass” Sample QC, independent of 
measured value.

Calibrator/IPC 
precision

All products •	 Use data in NPX units

•	 Include all replicates that “Pass” Sample QC, independent of 
measured value

Sample Control 
Accuracy

Products providing 
results in absolute 
quantification units

•	 Use data in absolute quantification units

•	 Include all replicates that “Pass” Sample QC, independent on 
measured value. pg/mL values for NPX outside of the curve 
range is set to NA.

•	 Median for point estimate

Minimum number of 
valid Sample Control 
replicates

 Olink Target 48

 Olink Flex 

 Olink Focus

•	 2 replicates with Sample Control QC “Pass” and no instrument 
flag required

Minimum number 
of valid Negative 
Control replicates

All products •	 2 replicates with Negative QC “Pass” required

Minimum number of 
valid Calibrator/IPC 
replicates

 Olink Target 48

 Olink Flex 

 Olink Focus

•	 2 replicates with Calibrator QC “Pass” and no instrument flag 
required

Consequences of 
Assay QC deviations

All products •	 Minimum number of valid Calibrator/IPC replicates not 
reached:  
Assay Fail, only Ct data provided to user for this assay 

•	 All other Assay QC deviations:  
Assay Warning, all data types provided to user for this assay

NPX™ Signature Software User Manual 
Part 2: Technology description 

8. Normalization methods
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8.8	 Run QC
In Run QC the performance of the run as a whole is assessed. Warnings are triggered in case variation in 
internal controls is high, an excessive amount of samples or assays have QC deviations or if control data 
is missing (see below for details). Recommended thresholds are shown in the software user interface. Run 
QC supports the user to identify problematic runs, but Run QC deviations could also be triggered by for 
example mixing different Sample Types on the same plate.

If a too large variation is observed in either of the internal controls, review the data in the Plate Data view 
(refer to section 14.6 Plate Data). For troubleshooting guidance, refer to section 17. Deviating controls.

Run quality issues might also be causing systematic bias as measured by ANOVA tests. Go to the Metrics 
view for more information, refer to 14.2 Metrics. 

Median absolute 
deviation of internal 
controls

All products •	 Use data in NPX units.

•	 Separate for project samples and control samples. 

•	 The MAD should be less than 0.23 for samples and less than 
0.25 for external controls.

Number of warned or 
failed samples

All products •	 Only use project samples. 

•	 No more than 1/6 of customer samples are allowed to be 
warned or failed.

Number of warned or 
failed assays

All products •	 Only use assays (excluding internal controls). 

•	 No more than 1/9 of the assays are allowed to be warned or 
failed.

Minimum number of 
valid Sample Control 
replicates

 Olink Target 48

 Olink Flex

 Olink Focus

•	 2 replicates with Sample QC “Pass".

Minimum number 
of valid Negative 
Control replicates

All products •	 2 replicates with Negative Control QC “Pass” required.

Minimum number of 
valid Calibrator / IPC 
replicates

All products •	 2 replicates with Calibrator/IPC QC “Pass”.
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8.9	 QC criteria
Criteria FAIL WARN

Sample QC

Incubation/Detection Control NPX 
deviation.

N/A Deviation > 0.3 NPX from plate 
median

Extension Control Data missing or >5 failed datapoints N/A

Assay QC

Calibrator replicates < 2 valid replicates N/A

Negative Control replicates N/A < 2 valid replicates

Calibrator precision N/A Too low (assay-dependent)

Sample Control replicates N/A < 2 valid replicates

Sample Control precision N/A Too low (assay-dependent)

Sample Control accuracy N/A Too low (assay-dependent; not 
applicable to panels without 
absolute quantification)

Intra-Assay %CV > 15% N/A

Inter-Assay %CV > 25% N/A

If a run fails to meet the acceptance criteria, or the QC is not accurate, please contact support@olink.com.

mailto:support%40olink.com?subject=
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Part 3: Operation

9. Introduction
Input data for Olink NPX Signature Software are run files from Olink Signature Q100 in .q100 format, 
Signature Q100 or Biomark runs exported as csv files from Fluidigm realtime PCR analysis software, heat 
map format, NPX Signature Software (v2.x) .osp project files and Olink NPX Signature Software (v1.x) .npx 
study files. The output data are obtained in NPX values. 

Further normalization against the Calibrators produces data in additional absolute quantification, provided 
in pg/ml, for the panels where absolute quantification is included.

NPX™ Signature

Annotate 
plates

QCImport 
Run Data

Normalization

Olink® Signature Q100 run data, 
Ct values

Sample Manifest

Panel Data File/
Panel Data Archive

Standard (CSV file)
Ct, NPX, Abs Quant Values

Extended (CSV file)

Analysis Report (PDF file)

NPX™ Signature Software User Manual 
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9. Introduction
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10. Files and information needed 
for analysis

10.1	 Panel Data Files and Panel Data Archive
The Panel Data Files or Panel Data Archive, depending on product, is needed to properly process and 
quality control your data. This file is unique to your panel version and reagent batch. The file is provided by 
Olink at the olink.com/software page.

 Olink® Target 48 and  Olink® Target 96
During a reagent batch release for Olink Target 96 or Olink Target 48, a new Panel Data Archive file will be 
issued. This file is a collection of all Olink Target Panel Data Files. It includes all previous Olink Target Panel 
Data Files along with the newly added Panel Data File. For how to import the file, refer to 11.2 Import Panel 
Data Files or Panel Data Archive. 

NOTE:  For the Olink Target Panels, it is sufficient to import the latest Panel Data Archive as this 
will include all previous released Panel Data Files.

The Panel Data Archive file is an encrypted .dat file that is compatible with NPX™ Signature v2.0 and later. 
The file is not backward compatible.

The file name will have the following format:

OlinkTarget_PanelDataArchive_[DATE]_NPXSv2.dat

Example:

OlinkTarget_PanelDataArchive_2025MAY22_NPXSv2.dat

 Olink® Flex and  Olink® Focus
For NPX Signature v2.0 and later, the Panel Data File will have the file format NPXSv2. The file is not 
backward compatibe. For how to import the file, refer to 11.2 Import Panel Data Files or Panel Data Archive.

For Olink Flex, the file name will have the following format:

OlinkFlex_PanelDataFile_[panelfilename]_NPXSv2.xml 

Example:

OlinkFlex_PanelDataFile_FXXX-XXXX_NPXSv2.xml

For Olink Focus, the file name will have the following format:

OlinkFocus_PanelDataFile_[NAME]_NPXSv2.xml 

Example:

OlinkFocus_PanelDataFile_CustomPanelName_NPXSv2.xml

NPX™ Signature Software User Manual 
Part 3: Operation 
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10.2	 Olink® Signature Q100 Run Data
Olink Signature Q100 run data can be imported directly into NPX™ Signature without any need for 
annotation or processing in advance. The following file types and formats are supported for import and 
analysis:

•	 Olink Signature Q100 export files: 

	– Accepted formats include .q100, .csv, .csvx, and .zip

•	 Fluidigm realtime PCR analysis software exported heat map or table files in .csv format. A csv file is 
needed to be able to analyze Biomark runs in NPX™ Signature.

10.3	 Sample Manifest file
The Sample Manifest is a structured table with four required columns and one row per well of a plate. This 
document is mandatory for importing individual runs into NPX™ Signature. Product specific templates 
for the Sample Manifest are available in Microsoft Excel (.xlsx) format and can be downloaded from the 
Project/Sample Manifest view, refer to 14.1.2 Sample Manifest, or from the Create Project dialog, refer to 
11.3 Create a new project.

The Sample Manifest can include up to 40 plates.

Using the Sample Manifest file
The Sample Manifest file provides a standardized layout for sample metadata. Although the format is 
standardized, the sequence of data entries can be rearranged to align with specific workflow requirements:

1.	 Rearrange the row order as needed to match the preferred layout.

2.	 Save the customized file for future use.

3.	 Upload the customized file during project setup.

Required columns
The Sample Manifest must include the following columns:

•	 WellID: 

	– Unique identifier of the well (for example A1÷H12).

•	 SampleID: 

	– Unique identifier for the sample.

	– 	Maximum length: 100 characters.

	– Must include at least one character which is not space.

	– May be reused across different plates for samples classified as External Control or NOT_USED, but 

must be unique within each individual plate.

	– Must be unique within the entire Sample Manifest for samples classified as Customer Samples.

	– Empty or unused wells do not require a SampleID; the system will assign an internal identifier 
automatically for processing purposes.

•	 PlateID: 

	– Unique identifier for the plate. This is the ID that will be included in the data export file.

	– Every row for a plate must have the same PlateID.

	– Maximum length: 100 characters.

	– Must include at least one character which is not space.

	– Up to 40 plates can be specified in a single Sample Manifest. If multiple plates are specified, the 
PlateID for each plate must be different.

NPX™ Signature Software User Manual 
Part 3: Operation 
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•	 SampleType:

	– Type of sample. 
Refer to 14.1.2 Sample Manifest for more information about the different sample types. 

Sample Manifests used in NPX Signature Software v1.x can be updated to be used in NPX Signature v2.x, if 
the requirements above are fulfilled.

The following sample types can be defined in the Sample Manifest file:

Sample Type Olink® Target 96 Olink® Target 48 Olink® Flex Olink® Focus

NOT_USED √ √ √ √

SAMPLE √ √ √ √

NEGATIVE_CONTROL √ √ √ √

SAMPLE_CONTROL √ √ √

SAMPLE_CONTROL_1 √

SAMPLE_CONTROL_2 √

SAMPLE_CONTROL_3 √

SAMPLE_CONTROL_4 √

CALIBRATOR √ √

CALIBRATOR_A √

CALIBRATOR_B √

CALIBRATOR_C √

INTERPLATE_CONTROL √

10.4	 NPX™ Signature Study File (.npx)
Study files previously created in NPX Signature v1.x can be migrated into NPX Signature v2.x. Refer to 11.5 
Migration of NPX™ Signature Software v1.x projects for more information.
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11. Operating workflow
This section describes how you analyze data step-by-step in NPX™ Signature Software. The following steps 
are included in the standard operating workflow:

1.	 Download Panel Data Files or Panel Data Archive.

2.	 Import Panel Data Files or Panel Data Archive.

3.	 Create a new project.

	– Select Panel and Panel Data File version

	– Import Run data

	– Import Sample Manifest

4.	 Perform quality control.

5.	 Export result files.

6.	 Finalize the project.

11.1	 Download Panel Data Files or Panel Data Archive 
If running an Olink Target 48 or Olink Target 96 project, a panel data archive must be downloaded. Go to 
Olink.com/software/download and download the Panel Data Archive. This Panel Data Archive contains all 
Olink Target Panel Data Archive.

For Olink Flex and Olink Focus projects, the Panel Data Files are provided by Olink.

For information about the Panel Data Files, refer to 10.1 Panel Data Files and Panel Data Archive.

11.2	 Import Panel Data Files or Panel Data Archive
Before creating a project, corresponding Panel Data Files must be imported into the NPX Signature 
Software.

The following steps must be repeated when new panel versions are needed and have been downloaded 
from the Olink web page or provided by Olink.

1.	 On the start page, click Manage panel data files. 
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2.	 The view lists all Panel Data Files uploaded to the current version of NPX Signature Software.  
Click Upload panel data file. 

3.	 Browse for files to upload. Click Open. 
The uploaded Panel Data Files will be listed.  
Click Back to go back to the start page. 
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11.3	 Create a new project 
1.	 Click Create a new project. 

2.	 Select Product Type.  
Enter Project name and Sample matrix (optional).  
If Panel Data Files have not been added, the corresponding product types can not be selected and the 
corresponding icon will be blurred. 
Click Select Panel Data.
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3.	 Select Panel(s). Use the Version dropdown menu and select Panel Version. Panel Version depends on 
the used reagent batch and can be found on the Lot configuration sheet provided with the reagents. 
To deselect, uncheck the checkmark box next to the panel.  
Click Import Files.  
Alternatively, you can also select Save without run data to create the project in advance without adding 
runs directly.  
For Olink Focus, select either absolute or quantitative panels. It is not possible to combine them in one 
project. 
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4.	 Upload Run Data and corresponding Sample Manifest files.   
Either drag and drop one or more files, or click on the dotted square and browse for preferred file(s). 

 

The Sample Manifest is required to define the Sample Types. A template can be downloaded in this step 
clicking Download template. The template can then be uploaded to the software as a Sample Manifest.

NOTE:  Files must be closed when uploaded to the NPX Signature Software.

5.	 Uploaded files will appear under each title/box and a confirmation of successful import will show.  
Click Annotate Run Data. 
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6.	 Choose for each Run Data file, the corresponding Panel and Sample Manifest for all Plates. 
A Sample Manifest cannot be used for multiple plates within the same panel.  
A Sample Manifest can be used for plates in different panels 
Click Create Project.  

7.	 Browse for folder to save the project folder.*

* In order to reduce the risk of file corruption due to potential limitations in network connectivity while using a VPN, it is recommended  
to save projects locally. By working directly from local storage, interruptions can be minimized and it can be ensured that the progress is  
consistently saved. Once the project is complete, it can be uploaded or synchronized to a network location after disconnecting from the  
VPN or when network stability improves.

The project will be stored as a folder including a project file with the extension .osp (Olink Signature 
Project). It is possible to open the project by double-clicking on the .osp file.

For how to import a project created in NPX™ Signature Software v1.x, refer to 11.5 Migration of NPX™ 
Signature Software v1.x projects.
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11.4	 Import a split Olink® Target 48 in version 2.x
When downloading the templates for Olink Target 48, two files are provided. These templates are intended 
for use during project creation when a 96.96 run is being imported.

1.	 Under Product Type, select your product and fill in the project details.

2.	 Select run(s) and Sample Manifest.

 

3.	 Select Sample Manifests for the split run and click Create project.
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11.5	 Migration of NPX™ Signature Software v1.x projects
Projects created in the old version of the NPX Signature Software (v 1.x) can be migrated into the new 
software (v 2.x). A migrated project will be saved as a new project (.osp). It will not replace the old project 
(.npx).

The old Panel Data File in the old NPX Signature Software v1 format will not be migrated in NPX Signature 
Software v2. A Panel Data File or an Panel Data Archive with the new format (NPXSv2) must be imported 
into the software before migrating the project. For more information about the Panel Data File, refer to 10. 
Files and information needed for analysis.

11.6	 Migrate a project
1.	 Start the NPX Signature Software and import Panel Data File, according to 11.2 Import Panel Data Files 

or Panel Data Archive.

2.	 On the start page, click Open an existing project. 

3.	 Browse for a project to migrate. Click Open.

4.	 A popup window will be prompted. Click Migrate. 

5.	 Browse for a folder to save the migrated project in. Click Select folder. 
The project is migrated and the Project view will be shown.

6.	 The project is created and all files needed for quality control are imported.
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11.7	 Migration information
The following information must be considered when migrating a project.

•	 If all data points in an assay were manually failed individually in NPX Signature Software v1.x, NPX 
Signature Software v2.x will treat the assay as manually failed. 

•	 A manual fail of data points will be migrated, with the exception of the above.

•	 A manual sample fail will be migrated.

•	 Normalization and QC will be re-calculated based on the migrated data. For more information, refer to 
Part 2: Technology description.

•	 It is not possible to have different normalization types within a project. Normalization types will be set 
to IPC normalization for Target 96 projects with mixed settings of normalization methods. Projects with 
consistent normalization types will retain the original setting.

•	 Sample Manifests not connected to any plates will not be migrated.

•	 SampleIDs with non-alphanumerical characters will be trimmed to only include alphanumerical 
characters and the following special characters “.”, “-“, “_”, <space>, and “#”. If the SampleID only 
contains non-alphanumerical characters, the SampleID will get a name based on the PlateID and WellID.

•	 PlateName will be changed to PlateID.

•	 PlateIDs with non-alphanumerical characters will be trimmed to only include alphanumerical characters 
and the following special characters “.”, “-“, “_”, <space>, and “#”.

•	 PlateID must be unique in NPX Signature Software v2.x. For duplicates, a suffix starting on 1, will be 
added to the PlateID name.

•	 SampleID of sample type Sample within a panel must be unique in NPX Signature Software v2.x. For 
duplicates, a suffix starting on 2 will be added to the SampleID name.

11.7.1	 Changes in project name
During the migration, a copy of the project will be created, and the old project file will be kept as it is. 

When saving the migrated project, a folder is created. NPX Signature Software creates a sub folder, with 
the same name as the NPX file. Both the name of the NPX file, and the project name, may change name, 
according to the following rules:

•	 Minimum name length: 1 characters 
If the length of the project name is shorter than minimum length, the new project name will be: 
"MyProject".

•	 Maximum name length: 150 characters 
If the length of the project name is longer than maximum length, all characters after the first 150 
characters will be stripped.

•	 Allowed characters: [a-z][A-Z][0-9]_-.#(whitespace) 
If the project name contains other characters than above, these characters will be replaced with "-" 
(dash).

•	 Project name can't end with the character "." (dot) 
If the project name ends with ".", ALL "." in project name will be replaced with a "-" (dash).

Examples

BEFORE migration:  	 AFTER migration: 
abs?!@#$%abs 		  abs---#--abs 
(empty) 			  MyProject 
abs åäö 			   abs --- 
abs.123. 			   abs-123- 
abs123_-.# 		  abs123_-.#
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11.8	 Perform quality control
Refer to section 14. Views for guidance on how to use the different views to perform quality control. The following steps are suggested 
best practices; however, they do not need to be followed to successfully perform quality control.

1.	 Go to Plate Details.

	F Ensure that it is the correct Sample Manifest.

	F Ensure that it is the correct number of samples and Sample ID .

	F Ensure that it is the correct file path and correct combination of Sample Manifest and file path.

2.	 Go to QC Summary.

	F Check the overview of number of earned and failed samples and assays. Check if something sticks out, if there's a plate issue.

3.	 Go to Sample QC.

	F Check the warned assays. If there are many warned assays, go to Run QC to identify which assays stand out.

	F Check the rest of the values. 

3.1.	 If there are many errors, go to Heat Map.

	F Check if any of the warned or failed assays contain outliers. 

3.2.	 If an outlier is detected, go to Workspace.

	F Set the sample as failed.

3.3.	 Go back to Sample QC.

3.4.	 Check that the results are satisfying. If not, repeat step 4.1÷4.3.

4.	 Go to Plate Data.

	F Check internal controls in Ct Value. Check differences and that the values are within the interval.

	F Check the NPX Value and scroll and see if there's a pattern. If so, compare with Ct Value.

5.	 Go to Heat Map.

	F Check all samples in NPX Value. Ensure that no values appear unusual or indicate potential outliers.

	F Check row and column, plate by plate, to identify any systematic errors. 

	F Check sample type one by one.

6.	 Go to Detectability.

	F Ensure that the detectability is satisfying.

	F  Ensure that no LOD values in the table are missing out.

7.	 Go to Plate Variation.

	F Check each assay individually, first in Ct Values and then in NPX Values, to ensure that the randomization appears correct. All 
boxes should be on the same level, which is especially important when working with more than one plate.

8.	 Go to Metrics.

	F For all plates, ensure that the Intra CV is not too high. 

9.	 Go to Amplification Curves.

	F Check for spikes in the curves.
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11.8.1	 Bimodal assays ( Olink® Target 96)
Some assays can show a bimodal profile. This can be dependent on the sample matrix. The plate view 
pattern and a high assay CV can indicate if an assay is bimodal. In that case it is recommended to use IPC 
Normalized NPX values for these assays. 

For bimodal assays the recommendations are to:

•	 Select Intensity Normalization.

•	 Export Extended Report for the whole project. 
The extended report will include both Intensity Normalized and IPC Normalized NPX values.

No assay is set per default as bimodal in NPX Signature Software v2.x. High assay CV and distribution in the 
Plate Variation view are a hint to detect bimodal assays.

For more information about bimodal assays, please refer to https://olink.com/knowledge/publications.

11.9	 Export result files
Three different files can be exported from the NPX Signature Software: Standard Export, Extended Export, 
and Analysis Report. For more information about the files and file formats, refer to 12. Result files. To export 

the file, go to Options → Export, and select the preferred file type to export.

https://olink.com/knowledge/publications
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11.9.1	 Preparing to Export the Analysis Report
To ensure that all required report details and metadata are included in the analysis report, the input form 

must be completed prior to exporting the file. Navigate to Options → Analysis Report Input.

Fill in the required fields, then choose either Save without exporting or Save & Export.
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12. Result files
Results can be exported in 3 formats. Standard (.csv) or extended (.csv) and as Analysis Report (.pdf).

12.1	 CSV files
CSV export files can be exported based on either relative quantification or absolute quantification, 
depending of the project type. Additionally, they are available in two formats: standard and extended. 

Below is an overview of the different file types and what each version includes.

In some regional configurations, Excel uses a comma (,) as the decimal separator instead of a period (.). The 
NPX file uses periods, and if Excel expects commas, values may be misinterpreted as thousands.

To verify Excel’s decimal separator setting:

1.	 Open Excel.

2.	 Navigate to File → Options → Advanced → Editing Options.

3.	 Confirm that the decimal separator matches the format used in the exported NPX file,  which is the 
period (.).

12.1.1	 CSV files for RELQ
CSV files for Relative Quantification (RELQ) are for Olink Target 96 and Olink Focus panels with relative 

quantification.

Column Description Type/example Standard Extended

Product Type of product. String 
TARGET96, FOCUS

√ √

Panel Panel name. For example "Olink Target 
96 Cardiovascular II"

√ √

PanelVersion Version of Panel Data File used. For example 902001 √ √

PlateID Name of the plate the sample was 
run on.

√ √

WellID Well on 96-well plate where sample 
was run.

√ √

SampleID The annotated Sample ID. √ √

SampleType The annotated Sample Type, listed 
as included in the product and data 
export file type.

√ √

Assay Short name for assay, taken from 
Panel Data File.

√ √

UniProt UniProt ID for assay. √ √

OlinkID OlinkID for assay. √ √

Ct Cycle threshold reading from qPCR 
instrument.

Decimal number √ √

NPX NPX for chosen normalization. Decimal number or NA √ √

LODNPX Limit of detection on NPX scale. Decimal number or NA √ √

BelowLOD Indicates if value is strictly below 
LOD.

TRUE, FALSE, or NA √ √ 

SampleQC Shows the QC status of the sample. PASS, WARN, FAIL, or 
MANUAL_FAIL

√ √

AssayQC Shows the QC status of the assay. PASS, WARN, FAIL, or 
MANUAL_FAIL

√ √
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MissingFreq. Frequency of missing data  
(below LOD or NaN).

Decimal number √ √

Normalization Type of normalization used in 
project.

IPC Normalized or  
Intensity Normalized (v.3)

√ √

SoftwareVersion Software version of the NPX 
Signature Software used for panel 
calculations and normalization.

√ √

SoftwareName Name of software. NPX Signature √

AssayType Type of assay. √

IPCNormalizedNPX IPC normalized NPX values. Decimal number or NA for 
Target 96

NA for Focus

√

LODIPCNormalizedNPX LOD for IPC normalized NPX. Decimal number or NA √

QCDeviationDetCtrl QC deviation for Incubation Control Decimal number √

QCDeviationIncCtrl QC deviation for Detection Control. Decimal number √

12.1.2	 CSV files for ABSQ
CSV files for ABSQ, Absolute Quantification, for ABSQ are for Olink Target 48, Olink Flex and Olink Focus 
panels with absolute quantification. 

Column Description Type Standard Extended

Product Type of product TARGET48, FLEX, FOCUS √ √

Panel Panel name For example "Olink Target 
48 Cardiovascular II"

√ √

PanelVersion Version of Panel Data File used. For example 902001 √ √

PlateID Name of the plate the sample was 
run on

√ √

WellID Well on 96-well plate where sample 
was run.

√ √

SampleID The annotated Sample ID √ √

SampleType The annotated Sample Type, listed 
as included in the product and data 
export file type.

√ √

Assay Short name for assay, taken from 
Panel Data File.

√ √

UniProt UniProt ID for assay. √ √

OlinkID OlinkID for assay. √ √

Ct Cycle threshold reading from qPCR 
instrument.

Decimal number √ √

NPX NPX value. Decimal number or NA √ √

LODNPX Limit of detection on NPX scale. Decimal number or NA √ √

BelowLOD Indicates if value is strictly below 
LOD.

TRUE, FALSE, or NA √ √ 

QuantifiedValue Quantified value of the sample. Decimal number √ √

Unit Unit for assay from Panel Data File. TRUE, FALSE, or NA √ √

LODQuant Limit of detection on quantified 
scale based on the Negative 
Controls.

Decimal number √ √

LLOQ The lower limit of quantification as 
set in the Panel Data File.

Decimal number √ √
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LQL The higher value of either the LLOQ 
from the Panel Data File or the 
LODQuant value computed based 
on the Negative Controls.

Decimal number √ √

BelowLQL Indicates if QuantifiedValue is 
strictly below LQL.

TRUE, FALSE, or NA √ √

ULOQ The upper limit of quantification as 
set in the Panel Data File.

Decimal number √ √

AboveULOQ Indicates whether Quantified value 
is strictly above ULOQ.

TRUE, FALSE, or NA √ √

SampleQC Shows the status of the sample. PASS, WARN, FAIL, or 
MANUAL_FAIL

√ √

AssayQC Shows the status of the assay. PASS, WARN, FAIL, or 
MANUAL_FAIL

√ √

MissingFreq Frequency of missing data  
(below LOD or NaN).

Decimal number √ √

Normalization Type of normalization used in 
project.

For example Calibrator 
Normalized

√ √

SoftwareVersion Software version of the NPX 
Signature Software used for panel 
calculations and normalization.

√ √

SoftwareName Name of software. NPX Signature √ √

AssayType Type of assay. √

QCDeviationDetCtrl QC deviation for Incubation Control Decimal number √

QCDeviationIncCtrl QC deviation for Detection Control. Decimal number √
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12.2	 Analysis Report
The analysis report is a PDF file that can be generated from the NPX Signature Software. The analysis 
report summarizes the quality analysis of the project. It contains basic information and descriptions of the 
project. 

Go to Options → Export → Analysis Report. Browse for preferred folder to save the Analysis Report and 
click Save. 

To ensure that all required report details and metadata are included in the analysis report, the input form 
must be completed prior to exporting the file. To edit the Analysis Report Input, go to Options → Analysis 
Report Input. Fill in the required fields, then click Save & Export.

The Analysis Report contains the following:

•	 Project information

	– Sample matrix

	– Project specific comments

•	 Quality Control

	– Summary of Quality Control of samples

	– Summary of Quality Control of assays

	– Intra- and Inter-Assay Coefficient of Variance (%CV)

	o Intra-Assay %CV

	o Inter-Assay %CV

•	 Protein detection and quantification results

	– Number of proteins with NPX above LOD in >75% of the samples

	o No of detected proteins / Total numbers of proteins

	o Detected proteins (%)

	– Number of proteins quantified within LOQ in >50% of the samples (only for AbsQ products)

	– Data output

•	 Samples that did not pass QC

•	 Observed deviations

•	 Downstream analysis

•	 Software version information and copyright information
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12.2.1	 Customize the Analysis Report
It is possible to add a custom logo image to the title page of the Analysis Report. Supported image formats 
are: bmp, png, jpeg, and gif.

4.	 Open a text file and fill in the following information:

{ 
"LogoFilePath": "<path to file>", 
"LabName": "<Service Lab Name>" 
}

Where <path to file> is the complete path to image file, including the file name of the image and  
<Service Lab Name> the name of laboratory or company or similar. For example:

{ 
"LogoFilePath": "C:/pictures/IMG_01234.JPG", 
"LabName": "<SuperLab>" 
}

5.	 Name the file certificate.json. Remove the file format .txt, the file type must be .json.

6.	 Place the file in the folder %LocalAppData%/Olink/NPX-Signature/Settings.
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Part 4: User Interface

13. General

9

7

3

8

654

2

1

No Part Description

1 Version number Specifies the version number of the software.

2 View menu For more information about the different views, refer to 14. Views.

3 Plate Selection Select plate and panel to display.

4 Minimize Minimize or maximize the left menu.

5 Header section Displays the name of the active project, along with the selected panel and 
plate listed below.

6 Options Menu for modifying the project data and for exporting results. Refer to 
13.2 Options menu.

7 Project Actions menu Menu for handling the project and software settings. Refer to 13.3 Project 
Actions menu. 

8 Main view Shows the selected view from the View menu.

9 Normalization Shows the selected normalization method. To change normalization 
method, refer to 13.2 Options menu.
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13.1	 Plate Selection

This menu shows the selected panel and plate. Click the small arrow to show or hide the list of plates. Select 
a specific plate by clicking its name. 
The navigation allows the use of shortcuts to move between panels and plates. If there is no next or 

previous plate or panel available, the shortcut will have no effect.

•	 Press the Ctrl key and the . (period) key at the same time to move to the next plate.

•	 Press the Ctrl key and the , (comma) key at the same time to move to the previous plate. 

•	 Press and hold Ctrl and Shift, then press the . (period) key to move to the next panel. 

•	 Press and hold Ctrl and Shift, then press the , (comma) key to move to the previous panel. 

13.2	 Options menu

Menu Expansion Description

Import Sample 
Manifests

÷ Import Sample Manifest. Refer to 11.3 Create a new project

Import Runs ÷ Import run files. Refer to 11.3 Create a new project.

Select Panel Data ÷ Change Panel Data File versions for the imported panels.

Export Standard Export

Extended Export

Analysis Report

Export the result files. Refer to 12. Result files.

Analysis Report 
Input

÷ Use this option to enter the required report details 
and metadata for the Analysis Report. The information 
provided in this section will be included in the final 
exported report. 

Normalization IPC Normalized

Intensity Normalized (v.3)

Change the normalization method. This applies only to 
Target 96.
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13.3	 Project Actions menu

Menu Description

New Project Create a new project. Refer to 11.3 Create a new project.

Open Project Open a saved project.

Save Project Save the current project. 

Create anonymized project copy Create a copy of the current project, that is anonymized.

About & Licensing View software version, copyright, and license information

Close Project Close the current project.

Quit NPX Signature Close down the software.
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14. Views 
Project
Provides a summary of the project, including the number of runs, panels, sample 
manifests, and any samples with warnings or failures.

Metrics
Shows evaluation of systematic bias. Gives an indication of the overall data quality of 
the selected panel and includes results of the selected panel.

Plate Details
Shows the plate layout, run details, panel information and plate status. Sample 
Manifest can be applied and plates can be excluded or deleted.

QC Summary
The Quality Control Summary view displays a summary of the plate info and QC details 
per plate for the entire project

Sample QC
Shows a diagram of the deviation from Median / of the incubation and detection 
controls in NPX for all samples and external controls of the selected plate, together 
with a table of Assay QC and Run QC.

Plate Data 
Shows the values of NPX, Ct, and Quantified values (if applicable) for internal controls 
and assays for each sample per plate. Assess if there are patterns in the plate (row or 
column) representing a possible technical error. 

Workspace 
Displays data of a plate or panel in a grid view, depending on the based on the option 
chosen in the upper left corner. When either NPX or Quantified Values is selected, the 
LOD (Limit of Detection) is shown at the bottom of the view. This view also allows for 
manual QC (manually failing data), and reviewing both the values and status for all 
samples and external controls. 

Amplification Curves 
Shows the amplification curves for all samples and plates in Ct.

Heat Map 
Displays the values of datapoints in the plate or panel in a red-and-blue color scheme.
Raw intensity levels (1 and 2) are shown in grayscale, providing a visual representation 
of the sample results.

Detectability
Shows a bar chart of the frequency of missing data per assay, indicating the 
percentage of data above LOD for all plates in the selected panel. Table Data shows 
LOD values for each assay and plate within the selected panel.

Plate Variation 
Shows box plots representing the deviation from the plate median of each sample, 
both across plates and within the selected panel.

History
Shows a log of all actions performed in the project.

Help Panel
A help panel can be accessed using the Information icon in the upper-right corner of 
each view. The panel provides information about the features and functions specific to 
that view.
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14.1	 Project
The Project view contains two different pages: Overview and Sample Manifest. Expand the Project menu to 
reach the different views.

14.1.1	 Overview

General: 
The Overview provides a summary of the project, displaying the number of Sample Manifests, plate and 
instrument runs, panels and other key metrics. It also highlights any samples that have failed or triggered 
warnings.

Useful for:
•	 Showing information on the panels, one panel at the time.

•	 Monitoring the progress of the QC process, shown as a percentage at the bottom of the view.

•	 Checking whether an Analysis Report has been generated and viewing the date and time of the most 

recent report.

Functions:
•	 Failed and warned samples are shown to the right.

•	 Project Name and Sample Matrix can be edited by clicking the Edit link next to the respective fields.

•	 Internal notes can be added in the dedicated field.
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14.1.2	 Sample Manifest

General:
The Sample Manifest view shows the Sample Manifest, use the dropdown list to select Sample Manifest to 
view. Viewing them does not change the Sample Manifest used for the selected plate.

The Sample Types are defined in the Sample Manifest. Changes to Sample Types in the sample positions 
must be done directly in the Sample Manifest and then be uploaded again. To upload the new Sample 
Manifest, go to the Options menu and select Import Sample Manifests.

The Sample Types are based on the color code that differs between the products. Definitions of the colors 
are shown to the right of the plate layout.

Useful for:

•	 Getting an overview of each Sample Manifest imported in the project.

Functions:
•	 Use the Sample Manifest dropdown list to Sample Manifest to view.

•	 Click Delete Manifest to delete the selected Sample Manifest. A Sample Manifest cannot be deleted if it 
is connected to a run data.

•	 Use the Template dropdown menu to select template to use.

•	 Click Export Template to export the selected template as a .xlsx (Excel file).
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14.2	 Metrics
General:

The Metrics view displays parameters related to systematic bias that need to be evaluated for each plate 

and panel, along with their recommended values.

In addition to numeric values, the table may include the following indicators:

•	 N/A (Not Applicable): This label is used for metrics that are undefined in the given context. For example, 
%CV (Inter) for Plate Metrics will always be marked as N/A, since %CV Inter for a single plate is not 
defined. 

•	 “no data”: Appears when there is insufficient data to calculate a metric. For example, %CV (Inter) for 
Panel Metrics will display “no data” if the panel contains only one plate. At least two plates are required 
to calculate this metric. 

Note: The Metrics view may take some time to load due to the number of calculations.

Useful for:

•	 Checking the tendencies regarding systematic bias.

•	 Getting an overview of the different ANOVA's. They give the following indications:

	– Row ANOVA: 
May indicate pipetting errors or issues with sample randomization. High values suggest row-wise 
randomization or an issue with a pipette channel. If elevated, inspect the Plate Data and heat map 
for row-based patterns.

	– Column ANOVA: 
Similar to Row ANOVA, it can point to pipetting errors or poor randomization. High values suggest 
column-wise randomization or pipetting inconsistencies. If elevated, review the Plate Data and heat 
map for column-based patterns.

	– Plate ANOVA: 
Highlights variation between plates.

•	 Checking the quality of the laboratory performance, including protein detection consistency.

•	 Comparing different normalization methods (Only for Olink Target 96).
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Functions:

For each panel, the following information is displayed:

•	 Plate ANOVA 

•	 Row ANOVA 

•	 Col ANOVA

•	 Warned/Failed samples

•	 Proteins >75%

•	 %CV (Inter)

•	 %CV (Intra)

14.3	 Plate Details
General:

Plate Details displays information about the selected plate, along with options to include, exclude, or delete 
plates. However, if a value is provided for 'Rerun Of', that value will be used for sorting instead of the Plate 
ID.

Useful for:

•	 Include, exclude, or delete the selected plate.

Functions:

•	 For each plate, the following information is displayed:

	– Properties

NPX™ Signature Software User Manual 
Part 4: User Interface 

15. Views



44

	o Plate ID

	o Entered Rerun

	o Selected Sample Manifest

	o Run name

	o Date

	o Instrument

	o Barcode

	o File path

	– Panel Information

	o Panel type

	o Panel version

•	 To annotate a plate as a rerun, use the Edit link located next to the Rerun of label. Click Edit and a text 
box will appear, allowing a note to be entered indicating that the plate is a rerun.

•	 Use the Sample Manifest dropdown menu to change Sample Manifest. Click Apply.

•	 Use the Plate Status buttons to Include or Exclude the plate, or to delete it.

	– An included plate is included in the QC calculations.

	– An excluded plate is not included in the QC calculations.

	– A deleted plate is deleted from the project. This action cannot be undone.

•	 Add comments in the Plate Notes. Comments will not be included in the Analysis Report.

NPX™ Signature Software User Manual 
Part 4: User Interface 

15. Views



45

14.4	 QC Summary
General:

The QC Summary shows an overview of all plates in the project. Note that the list is too wide to be shown in 
one view. Use the < Back and Next > buttons or the scrollbar to see all information for each plate.

The values in bold on the Incubation, Detection and Extension control columns represent the max-min 

difference of the customer sample Ct values for the respective internal control assay per plate.

Useful for:

•	 Quickly assessing if there are plates with a lot of warned or failed samples and assays. 

•	 Quickly assessing the Ct ranges of the internal controls for all plates.

•	 Quickly getting an overview of median absolute deviation of internal controls for all plates. 

•	 Giving a summary of all plates in the project.

•	 Setting the QC status of a plate as reviewed.

•	 Checking that the file path and run names are correct, to verify that the correct Sample Manifest has 
been applied.

Functions:

•	 Select all plates by ticking the top box.

•	 Select plate(s). Use the Actions dropdown menu to Include or Exclude the selected plates or to remove 
the selections from the project.

•	 Set a plate QC as QC reviewed by sliding the toggle switch for QC Reviewed (Y/N) to the right. To set the 
status to not reviewed, slide the toggle switch to the left. This will change the QC status progress bar in 
the Project Overview.
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14.5	 Sample QC
General:

The Sample QC view shows a scatter plot of deviation from median of the incubation and detection controls 
in NPX for all samples and external controls of the selected plate. To the right, information about Assay 
QC and Run QC are shown in different tabs, together with recommended values. Both warned and failed 
samples and assays are shown in the tables, but not manually failed ones. 

The scatter plot uses the following symbols:
•	 Light blue line: The recommended threshold.

•	 Orange square: Incubation Control 1

•	 Blue-green diamond: Detection control

•	 Red cross: Indicates values that are “Not a Number,” (a replacement for data values below the LOD).

•	 Red data points (squares or diamonds): Samples warned because Incubation Control 1 or Detection 
Control deviated by more than ±0.3 NPX or had missing values.

•	 Outliers (red square or red diamond): Samples with deviations beyond ±1 NPX. Displayed at 1.0 for 
visibility. A red square marks an outlier for Incubation Control 1, and a red diamond marks one for the 
Detection Control. 

•	 Vertical dashed line: Separates sample data (left) from External Controls (right).

The X axis shows the samples and the Y axis the median NPX values.

Useful for:

•	 Get an overview of the samples and deviation from the median NPX of the incubation and detection 
controls.

•	 Find warned and failed samples and outliers.

Functions

•	 Hover over a sample to show the following information:

	– Sample ID 

	– Sample Type

	– Inc Ctrl 1 (deviation from median)

	– Det Ctrl (deviation from median)

	– Reason (reason for sample warning or failed)
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•	 The Run QC table shows the following information together with corresponding acceptance criteria:

	– Number of warned/failed samples

	– Number of warned/failed assays

	– Inc Ctrl 1 Samples (Median absolute deviation for the Incubation Control in samples)

	– Det Ctrl Samples (Median absolute deviation for the Detection Control in samples)

	– Inc Ctrl 1 External Controls (Median absolute deviation for the Incubation Control in control samples)

	– Det Ctrl External Controls (Median absolute deviation for the Detection Control in control samples)

•	 The Assay QC table lists all warned and failed assays, along with a description explaining the reason for 
each warning or failure, and the corresponding acceptance criteria.

Value ranges

Values between ±0.3:
Samples with internal controls inside the range passes the QC criteria.

Values between 0.3 and 1 / -0.3 and -1:
Samples with internal controls in this range are automatically warned. 

Values outside the range of ±1
Samples with internal controls outside this range are outliers. They are also warned. 

All outliers are automatically set to 1.0 in the graph. A red square marks Incubation Control and a red 
diamond Detection Control. To see the exact value, mark the outlier by clicking at it. The exact value is 
shown in the bottom of the screen. To visualize the outlier, hover over the plot while scrolling out using the 
mouse to change the scale of the plot.
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14.6	 Plate Data
General:
The Plate Data view displays NPX Value, Ct Value, and Quantified Value (if applicable) for both internal 
controls and assays for each sample on the plate. Review the data for any patterns across rows or columns 
that may indicate potential technical errors. 

Useful for:

•	 Get an overview of warned or failed samples.

•	 Check that all internal controls are good. A Ct range for each internal control is within 1 Ct per plate 
indicates evenly pipetted samples and reagents. 

•	 Scroll through all assays to find patterns. Patterns can indicate that there are laboratory technical errors.

Functions:

•	 Change data unit by selecting either Ct Value, NPX Value, or Quantified Value (if applicable).

•	 Use the Assay dropdown menu to change which assay to display, or use the arrow keys for mouse 
scrolling wheel for faster toggling.

•	 The bar below the plate shows the range of Ct Value, NPX Value, or Quantified Value (if applicable). The 
blue values are below median and red values are above median.

NPX™ Signature Software User Manual 
Part 4: User Interface 

15. Views



49

14.7	 Workspace
General:

The Workspace view shows values and status for all samples and external controls. In the workspace view, 
samples and assays can be manually failed. Single datapoints can be falied without failing an entire sample 
or assays.

The table uses the following colors:
•	 Dark grey: Missing Data

•	 Orange: Warned

•	 Light red: Failed

•	 Red border: Manual Fail

•	 Light grey: <LOD / <>LOQ (Only for Quantified values)

Useful for:

•	 Create manual fails.

Functions:

•	 Use the Data unit to show Ct Value, NPX Value, or Quantified Value (if applicable).

•	 Use the Bulk actions dropdown menu to Mark Selection as Failed. Click Apply. To undo this action, 
select Reset To Automatic QC in the dropdown list.

QC
•	 Apply manual QC. It is possible to fail a single datapoint, a sample or an assay. 

•	 Automatic QC will be recalculated and exclude manually failed data. 

•	 After applying manual QC, double check Sample QC, Run QC, and Assay QC.
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14.8	 Amplification Curves
General:

The Amplification Curves view displays the curves for selected samples, assays, and data points from the 
current plate, regardless of inclusion status. To select multiple items, hold the Ctrl key while clicking.

The Amplification Curves only displays Ct Values. The Ct refers to the number of cycles required to cross the 
detection threshold of the PCR amplification curve. Based on Ct values, the arbitrary, relative quantification 
unit NPX is calculated. 

The linear portion of each curve is in the exponential phase of PCR, where the amount of product, and 
therefore the signal, doubles after each cycle. The clustering of the amplification curves for each dilution 
should be tight.

The Y-axis shows on a log scale ΔRn, the magnitude of normalized fluorescence signal generated by the 
reporter at each cycle during the PCR amplification and the X-axis the number of cycles.

Useful for:

•	 Identifying and examining irregular amplification patterns.

•	 Viewing threshold and baseline values for the run. 

•	 Detecting spikes in the curves , which may indicate sample preparation issues.

Functions: 

•	 Select a sample to show the amplification curves.

•	 Select multiple samples, assays, or data points by holding the Ctrl key while clicking.

•	 Use the filter menu to select Sample Type. 
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14.9	 Heat Map
General: 

The Heat Map view contains a color-coded view for all values of all assays for samples and external controls 
in the chosen plate or all plates. By default, assays are displayed horizontally and samples are displayed 
vertically. The orientation can be changed using the toggle switch. When the orientation is switched, 
samples are displayed horizontally and assays are displayed vertically. 

The heat map displays deviations from the plate median for the selected assay using the following colors: 

•	 Blue: values below median

•	 Red: values above median

When raw data is available, the Heat Map can display Raw Intensity 1 (FAM-MGB fluorescence at qPCR 
cycle 5) and Raw Intensity 2 (FAM-MGB fluorescence at the final qPCR cycle). These raw intensity values 
are presented in grayscale and are always displayed using the Chip layout.

Note: The Deviation from assay median will not be displayed when either Raw Intensity 1 or Raw Intensity 2 
is selected as the data unit.
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Useful for:

•	 Finding systematic patterns within a plate and across multiple plates in a panel. It also facilitates 
comparison of external controls to detect outliers. Such outliers may indicate contamination and might 
need to be failed manually in the Workspace view, or they may suggest that an analyzed sample differs 
from the rest of the cohort.

•	 Get an overview of the alignment of the samples.

Functions:

•	 Change data unit by using the Data Unit dropdown menu. Select one of the following options: Ct Value, 
NPX Value, Quantified Value (if applicable), Raw Intensity 1, or Raw Intensity 2.

•	 Change heat map layout to sort the samples row-wise or column-wise based on the plate layout.

•	 Use the Sample Type dropdown menu to select display samples or external controls.

•	 Use the toggle switch to change the orientation of assay and sample display.

•	 Hover over any datapoint in the heat map to view detailed information, including:

	– Assay

	– Sample ID

	– Well ID

	– Plate ID

	– Deviation from assay median (not available when Raw Intensity 1 or Raw Intensity 2 is selected)

	– Value

•	 Zoom functions:

	– Zoom in or out using the mouse scroll wheel or the arrow keys on the keyboard.

	– Zoom to fit: will adjust the heat map to fit in the view.

	– Zoom to fit width: willl adjust the heat map to fit vertically.

	– Left align: will adjust the heaat map to align on the left of the view.

•	 To navigate the map:

	– Click and drag with the left mouse button, or use the arrow keys (Up, Down, Left, Right) to move the 
view.

	o Hold Shift and drag up or down to move vertically.

	o Hold Ctrl and drag left or right to move horizontally.
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14.10	Detectability
General:

The Detectability view provides a visual summary of protein detectability across the entire panel. The bar 
chart shows the selected panel, and the list shows LOD values for all plates in the panel. The bar chart uses 

the following color code:

•	 Blue: Valid data. Values above LOD, within the Limit of Quantification (LOQ) if applicable, and not 
manually failed or failed by automatic QC.

•	 Red: 	>LOD (for Olink Target 96 and Olink Focus with RelQ).  
	 <>LOQ (for Olink Target 48, Olink Flex, and Olink Focus with AbsQ).

•	 Grey: Missing data. Data not manually failed or failed by automatic QC.

Useful for:

•	 Check all detectability within the panel to get an indication of the condition of the samples.

•	 Check for data below LOD / outside LOQ.

•	 Check every assay at the same time.

•	 To verify consistency across plates, use the 'Limit of Detection' table to compare LOD values for each 
assay. LOD outliers can indicate contamination of negative controls.

NOTE:  For the Olink Target 48 panels, some assays can be expected to have LOD values above 2.5 
NPX. This should not affect the number of samples that can be quantified above the plate LOD.
For the Olink Target 96, the optimal range for LOD is ±2.5 NPX.

Functions:

•	 Mark an assay in the diagram to highlight it in the table, and mark an entry in the table to highlight it in 
the diagram.
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14.11	Plate Variation
General:

The Plate Variation view shows the distribution of sample values and their deviation from the plate median 
for each assay. It uses box plots to visualize Ct, NPX, or Quantified values (if applicable) for samples that 
have passed Sample QC.

Useful for:

•	 Comparing intensity distributions across plates.

•	 Identifying systematic variance in total intensity between plates.

•	 Detecting potential contamination by checking if box plots are aligned. Misaligned boxes may indicate 
contamination.

Functions:

•	 Switch data units by selecting between Ct, NPX, or Quantified values (if available).

•	 Use the Assay dropdown menu to select specific assays, or quickly switch between assays with the up/
down arrow keys or scroll wheel while hovering over the dropdown.

•	 Hover over the chart and scroll to zoom in or out to view different parts of the box plots.

•	 Click, hold and drag the plot to move it to view different parts of it.
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14.12	History
General:

The History view shows all events for the current project. Everything that is entered into the project are 
listed in the Project History list.

Useful for:

•	 Seeing what actions have been taken on the project.

Functions:

•	 Click on the Export button to export the project history as a CSV file.
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15. Keyboard shortcuts
The application supports several keyboard shortcuts that help perform common actions more efficiently.

Action Shortcut Description

Plate Selection

Move to the next plate Ctrl + . Press the Ctrl key and the . 
(period) key at the same time.

Move to the previous plate Ctrl + , Press the Ctrl key and the , 
(comma) key at the same time.

Move to the next panel Ctrl + Shift + . Press and hold Ctrl and Shift, 
then press the . (period) key.

Move to the previous panel Ctrl + Shift + , Press and hold Ctrl and Shift, 
then press the , (comma) key.

Project Actions menu  

Create a new project. Ctrl + N Press the Ctrl key and the N key 
at the same time.

Open an existing project. Ctrl + O Press the Ctrl key and the O key 
at the same time.

Save the current project. Ctrl + S Press the Ctrl key and the S key 
at the same time.

Close the current project. Ctrl + W Press the Ctrl key and the W key 
at the same time.

Exit the application. Alt + F4 Press the Alt key and the F4 key 
at the same time.

Heat Map

Move the view up, down, left, or right. Arrow keys (Up/Down/Left/Right) Move the view up, down, left, or 
right by press the Arrow keys.

Zoom in or out of the heat map Ctrl + Arrow keys (Up/Down/Left/
Right)

Press the Ctrl key and the 
Arrow keys at the same time.



57

Part 5: Troubleshooting

16. Introduction
This chapter describes issues that may arise during use of NPX Signature Software, or data issues during 
analysis of the studies, and how to solve these issues. 

NOTE:  The figures in the Troubleshooting sections are schematic only and do not reflect the 
current interface of NPX Signature Software.

16.1	 Warning messages
The list of warning messages is not complete. Other messages may appear. Please contact support@olink.
com if further guidance is needed.

In version 2.2 of NPX Signature, the term 'study' has been replaced with 'project'.

The following warnings may be displayed:

•	 Creating a New Project from the Welcome Screen

	– Creating a New Project and then clicking the Back button will discard all changes and prevent the 
creation of a project.

	o Select Cancel to continue working on the current project.

	o Select Continue to discard progress and return to the start screen.

•	 Opening and closing the Select Panel Data view without selection

	– Opening the Select Panel Data view and closing it without selecting a version will result in loss of all 
progress and no project will be created.

	o Select Cancel to return and continue with the project.

	o Select Continue to close the application and discard the project.

•	 Closing the Panel Data view after selecting a Panel Data version

	– After selecting a Panel Data version, closing the view will trigger a warning. Three options are 
available:

	o Cancel: Returns to the Panel Data view to continue editing.

	o Don’t save: Closes the application and discards all unsaved changes.

	o Save without run data: Saves the project without including run data.

•	 Changing the Product Type

	– Changing the Product Type after selecting it, along with the Project Name and Panel Data version, 
will reset all configuration settings.

	o Select Cancel to keep the current Product Type and continue.

	o Select Continue to change the Product Type and lose the existing configuration.

•	 Navigating back after selecting a Run Data Source and a Sample Manifest

	– When navigating back in the annotation process (step 4 of 4), after both Run Data Source and 
Sample Manifest have been selected, a warning message will appear, indicating that all annotations 
made in step 4 will be lost.

	o Select Cancel to continue with the current selections and annotations.

	o Select Continue to remove the selected files and discard all annotations.
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•	 Creating a New Project while another Is open

	– If a project is open and New Project is selected from the Project Actions menu, any unsaved changes 
in the current project will be lost. .

	o To save changes in the current project, click Save.

•	 Opening a project while another Is already open

	– If a project is open and Open Project is selected from the Project Actions menu, any unsaved 
changes in the current project will be lost. 

	o To retain the current project, click Save & close.

•	 Closing a project or the application

	– If a project is open and Close Project is selected from the Project Actions menu, or if the application 
is closed, any unsaved changes will be lost.

	o To save the project, click Save & close.
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17. Deviating controls
If the normalized value for internal controls for a specific sample deviates from the rest of the sample set, 
the sample does not pass Sample QC and is warned in the NPX Signature Software. 

Issue Explanation Reason Action

A sample is warned. A sample is warned 
when one or several 
internal controls 
deviate from the 
plate median for that 
specific sample.

All warned samples in a 
project are shown in the 14.1.1 
Overview in the right window 
called Failed or Warned 
samples. 

The behavior of the internal 
controls makes it possible to 
understand why the sample 
is warned. See the rest of this 
section for more information. For 
more detailed information about 
warned samples, go to the 14.5 
Sample QC view (Figure A) and 
the 14.6 Plate Data view (Figure 
B) 

Figure A.	 The Sample QC view shows the warned samples in red, both by Incubation Control and/or Detection Control. These data-
points are outside the recommended threshold of ±0.3 NPX limit which is visualized with the light blue lines. In the Sample QC view, 
the Run QC view indicates the number of warned/failed samples in the plate (4))

Figure B.	 Plate Data view corresponding to samples shown in Figure A . The 4 warning samples are shown with a flag symbol, some 
with lower or higher NPX values for different internal controls. 
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17.1	 Sample warned by Incubation Control
Issue Explanation Reason Action

A sample is 
warned due to the 
Incubation Control.

The NPX Value of the 
Incubation Control 
for this specific 
sample deviates 
more than 0.3 NPX 
from the plate 
median.

If the Incubation Control(s) 
deviate, but not the Extension 
and Detection Controls, this is 
an indication that something 
(most likely in the sample) is 
affecting only the Incubation 
Controls.

Refer to 17.1.1 Common reasons 
for deviating Incubation Control 
for examples.

17.1.1	 Common reasons for deviating Incubation Control
Possible cause Explanation Solution

Sample matrix If the sample matrix for the warned 
sample is different from the others on the 
same plate, the incubation environment 
can be different (Figure C). This can 
make the reaction  slightly more or less 
efficient.

Perform the QC evaluation for 
one sample matrix at a time.

Sample volume or concentration The sample volume is too high or too low 
or Incubation mix is to high or to low.

Set the affected samples as failed 
in the 14.7 Workspace view.  
If applicable, rerun from the 
Incubation step and make sure 
the correct volume is used.

Sample quality If the samples have pre-analytical 
variations this can introduce deviation 
within internal controls. 

For all sample quality 
considerations please refer to 
the "Pre-analytical variation 
in protein biomarker research" 
White Paper, refer to section 3. 
Associated documentation.

Sample Type Olink assays are validated for customer's 
matrix. Other sample matrices can 
contain factors that interfere with the 
immuno reaction step.

Standardize samples as much 
as possible (for example: for 
lysed cells and tissue, use similar 
concentration of protein in each 
sample).

Figure C.	 The Plate Data view shows Ct Value deviation for internal controls due to different sample matrices being present in the 
same plate (Rows A-D one sample type, Rows E÷H a different sample type), and thus affecting the incubation environment. This leads 
to warning samples.

NPX™ Signature Software User Manual 
Part 5: Troubleshooting 

18. Samples warned by Detection Control



61

18. Sample warned by Detection 
Control

Issue Explanation Reason Action

A Sample Control 
is warned by the 
Detection Control.

The NPX Value of the 
Detection Control for 
this specific sample 
deviates more than 
0.3 NPX from the 
plate median.

One example can be seen in 
Figure A. Data is normalized 
using the Extension Control. 
Since both Incubation 
Control and the Extension 
Control display decreased 
Ct-values, the normalization 
step will adjust the data. The 
Detection Control that did 
not show decreased Ct-values 
will be overcompensated 
by normalization against 
the Extension Control and 
thereby deviate from the 
rest of the sample set after 
normalization.

This type of flag is generally 
caused by the same reasons as 
warned Incubation Control. It 
is not uncommon that both the 
Incubation Control and Detection 
Control flag simultaneously, but 
with opposite “direction” in the 
14.5 Sample QC. This is seen when 
the warned sample affects both 
the extension and immunoassay 
step, but to different extent. See 
examples in section 17.1.1.

18.1	 Deviating external controls
Issue Explanation Action

High Intra-CV value Intra-CV value > 15%  
for Sample Controls 
within the same plate. 
The Sample Control 
replicates differ within 
the sample plate.

Check sample annotation of the Sample Controls. Check the 
row pattern for rows containing Sample Controls to make sure 
that none of the rows is an outlier (for example issue with a 
channel on one of the multichannel pipettes).

If one Sample Control replicate deviates from the other(s) and 
this pattern can be confirmed for several assays, this could 
indicate a manual issue with this replicate. In such case, that 
replicate can be failed and the remaining replicates used for 
CV calculation. 

 Please contact support@olink.com for further guidance.

High Inter-CV value Inter-CV value > 25% for 
Sample Control within 
the same plate.
The Sample Control 
replicates differ between 
sample plates.

•	 Check sample annotation of the control samples and that 
they pass QC. 

•	 If one Sample Control replicate deviates from the other(s) 
two and this pattern can be confirmed for several assays, 
this could indicate a manual issue with this replicate. In such 
case that replicate can be failed and the remaining used for 
CV calculation. 

•	 If applying intensity normalization, check for proper 
randomization between the plates within the project. (Only 
for Olink Target 96)

Please support@olink.com for further guidance.
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Issue Explanation Reason Action

High LODs that 
affect the number 
of samples that can 
be quantified above 
LOD.

Calculated LODs 
are out of expected 
range.

•	 Wrong Panel Data File.

•	 Wrong panel.

•	 Contamination of Negative 
Controls.

•	 Wrong annotation of 
Negative Controls, Sample 
Controls or Calibrators.

•	 Confirm annotation of 
Negative Controls, Sample 
Controls and Calibrators.

•	 Confirm datafile; reanalyze 
data.

•	 If applying intensity 
normalization, check for 
proper randomization 
between the plates within the 
project.

Please contact support@olink.
com for further guidance. 

Assay warning for 
Sample Control 
precision in  

 Olink Target 48
 Olink Flex 
 Olink Focus.

Sample Control intra 
CV > 30% for the 
given assay.

•	 Sample Control replicates 
differ within the same plate.

•	 Check sample annotation of 
the Sample Controls.

•	 Check the row pattern for rows 
with Sample Controls to make 
sure that none of the rows is 
an outlier (for example issue 
with a channel on one of the 
multichannel pipettes).

•	 If one Sample Control replicate 
deviates from the other 
two and this pattern can be 
confirmed for several assays, 
this could indicate a manual 
issue with this replicate. In 
such case that replicate can 
be failed and the remaining 
used for CV and accuracy 
calculation. 

Please contact support@olink.
com for further guidance.
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Assay warning for 
Sample Control 
accuracy in 

 Olink Target 48
 Olink Flex 
 Olink Focus.

Sample Control 
accuracy is > ±30% 
from expected value.

•	 Wrong Panel Data File 
version selected.

•	 Check that the correct Panel 
Data File version is applied.

•	 Check sample annotation of 
the Sample Controls and that 
they pass QC. 

•	 Check the row pattern for rows 
containing Sample Controls 
to make sure that none of the 
rows is an outlier (for example 
issue with a channel on one of 
the multichannel pipettes).

•	 If one Sample Control replicate 
deviates from the other 
two and this pattern can be 
confirmed for several assays, 
this could indicate a manual 
issue with this replicate. In 
such case that replicate can 
be failed and the remaining 
used for CV and accuracy 
calculation.

Please contact support@olink.
com for further guidance.

Assay warning for 
Calibrator precision 
in 

 Olink Target 48
 Olink Flex 
 Olink Focus

Calibrator CV > 30% 
for the given assays.

Calibrator replicates differ 
within the same plate.

•	 Check sample annotation of 
the Calibrators.

•	 Check the row pattern for 
rows with calibrators to make 
sure that none of the rows is 
an outlier (for example issue 
with a channel on one of the 
multichannel pipettes). If one 
Calibrator replicate deviates 
from the other two and this 
pattern can be confirmed 
for several assays, this could 
indicate a manual issue with 
this replicate. In such case 
that replicate can be failed 
and the remaining used for CV 
calculation. Failing a replicate 
will result in renormalization, 
and NPX and pg/mL Vaules 
will change.

Please contact support@olink.
com for further guidance.
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19. Inconsistent results detected

19.1	 Variation between plates - common reasons
Issue Explanation Reason Action

The “Plate ANOVA” value 
in the 14.2 Metrics view 
(Figure D) shows a high 
value. The variation is 
also shown on the 14.11 
Plate Variation view. 
(Figure E Plate variation 
should be solved by 
intensity normalization.)

The total NPX varies 
between plates.

•	 May be caused by insufficient 
randomization, meaning that 
the distribution of samples 
from different groups is not 
the same for all plates in the 
project.

•	 Other option is different 
sample groups and/or matrices 
are part of the plates.

If the samples are 
completely randomized, 
make sure that intensity 
normalization has been 
used. In case of different 
sample groups, create 
individual projects. 
The results will then  look 
like the example
in Figure F the same 
results as in Figure E after 
intensity normalization.

High Inter-CV value Inter-CV value 
> 25%.

•	 The Sample Control differ 
between sample plates.

•	 May be caused by insufficient 
randomization when using 
intensity normalization. The 
distribution of samples from   
different groups is not the same 
for all plates in the project. 
Using intensity normalization 
will than results in higher Inter-
CV values.

•	 Check sample 
annotation of the 
Sample Controls and 
that they pass QC. If 
intensity normalization 
has been used, ensure 
that randomization 
assumption is valid by 
comparing with IPC 
normalization

•	 Check if all samples are 
from the same project. 

Figure D.	 The Metrics view with a Plate ANOVA value that indicates variation between plates.
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Figure E.	 Plate variation indication technical deviation.

Figure F.	 The same results as in Figure E, after intensity normalization.
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19.2	 Variation within a plate - common reasons
Issue Explanation Reason Action

The columns or row 
ANOVA in the 14.2 
Metrics view show high 
values. The effects are 
visualized in the 14.6 
Plate Data tab.

Areas of a plate 
(columns and/
or rows) have 
systematically higher 
or lower values (Ct 
and/or NPX) than 
the rest of the plate.

•	 The variation is caused by the 
sample position on the plate. 
Within-plate effects are often 
caused by laboratory mistakes.

•	 The variation is caused by 
suboptimal randomization and/
or different matrices on the 
same plate.

See examples in the next 
table.

Position effects/patterns: visible only for Internal Controls

All Internal Controls are 
affected on Ct-level in 
a similar manner (all 
increased or decreased.)

One sample column 
or row consistently 
show deviating 
values.

•	 Pipetting error, for example 
pipette not pre- conditioned.

•	 Different matrices on the plate.

•	 Exclude data from 
analysis and/or rerun.

•	 Create individual 
projects per matrix.

Mistake during pipetting of the 
incubation mix, extension mix, 
detection mix, or samples.

Evaporation due to incomplete 
sealing of plate during incubation 
or PCR steps.

Exclude data from 
analysis and/or rerun.

Different sample matrices. QC matrices separately.

Forgotten to pause the PCR 
machine resulting in only a 
few minutes 50 °C instead of 
20 minutes

Rerun from Incubation 
needed.

Incubation Controls and 
Extension Control differ 
from Detection Control 
on Ct-level.

Incubation and 
Extension Controls 
show the same 
pattern, Detection 
Control shows 
another pattern.

•	 PCR instrument not good 
at keeping 50 °C, Detection 
Control not affected by 
extension step.

•	 Enzyme not added resulting is 
suboptimal extension step.

Rerun from Incubation 
needed.

May be pre-analytical (interfering 
factors may affect all controls but 
the Detection Control).

Contact support@olink.
com for further guidance.

Incubation Control differ 
from Extension and 
Detection Controls.

Incubation Control 
shows deviating 
pattern.

•	 Pre-analytical factors in 
samples that interfere with the 
immuno reaction.

•	 Contamination in samples, for 
instance GFP present. 

Few deviating samples: 

•	 Exclude samples from 
subsequent statistical 
data analysis.

•	 > 1/6th of samples 
deviating: Contact 
support@olink.com for 
further guidance.

Position effects/patterns: visible for samples and Internal controls

Columns/rows/parts of 
sample plate.

Patterning that 
follows sample 
naming/sample 
matrices.

•	 Different sample matrices.

•	 Suboptimal randomization.

QC matrices separately.

NOTE:  Make sure 
that the deviation 
cannot be explained 
with biological 
variation, i.e. that 
a unique sample 
group is placed on 
one column/row.
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Issue Explanation Reason Action

Gradient over the 
sample plate.

Upper or lower part 
or left and right 
part of the plate 
affected with clearly 
deviating values.

•	 IFC issue.

•	 Poor vortexing in extension 
step.

•	 Poor mixing of detection mix.

•	 Uneven temperature in PCR 
block.

Rerun.
Contact support@olink.
com for further guidance.

19.2.1	 Common problems and reasons for within-plate effects.
Problem Possible cause Figure reference

First column different than the rest of the plate 
(observed for Internal Controls).

The pipette was not 
preconditioned.

A specific column or columns is/are different 
than for the rest of the plate (observed for 
internal Controls).

A mistake when the incubation 
solution, extension mix, detection 
mix, or samples were pipetted.

Figure G

One row consistently different from the rest of 
the plate (observed for Internal Controls and/or 
samples).

The pipette tip in that specific 
position was not tight enough.

Deviating Plate Variation distribution for single 
assays on one plate.

Primer contamination. Figure H

A gradient from row A to row H. Pipetting was done at an angle.
The plates were not sufficiently 
vortexed.

Figure I

Figure G.	 Ct Values that show results of laboratory mistakes. Refer to table below for a description of errors performed on this run. 
The figure shows a Olink Target 96 project, but the behaviour is similar for other products.
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Figure H.	 Ct Values that show primer contamination of Incubation Control 2.

Column 4
(correct)

Column 7 Column 8 Column 9 Column 10 Column 11 Column 12

Incubation mix (µL) 3 3 3 3 3 6 3

Sample volume (µL) 1 1 1 0 2 1 1

Extension mix (µL) 96 96 192 96 96 96 96

Detection mix (µL) 7.2 14.4 7.2 7.2 7.2 7.2 7.2

PCR product (µL) 2.8 2.8 2.8 2.8 2.8 2.8 5.6

Figure I.	 Within plate effects due to incorrect or insufficient vortexing of the sample plate during sample dilution.
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19.3	 Extreme outliers - common reasons
Issue Explanation Reason Action

Extreme blue or red lines 
in heat map (when only 
selecting “samples” in the 
dropdown menu)
or outlier dots in Plate 
Variation view.

Sample with 
extremely low 
or high protein 
quantification.

•	 Incorrect dilution of samples.

•	 No sample added.

•	 Same columns two times 
sample added.

Fail sample.

Sample contains only a buffer 
with no protein content.

Investigate if a sample 
ressembles a Negative 
Control. If so, do not fail 
the sample.

19.4	 High NPX signals - common reasons
Issue Explanation Reason Action

Unexpectedly high 
NPX signals in diluted 
panel for the majority of 
samples.

•	 Low variation 
between samples.

•	 Saturated assays 
(may be visualized 
in 14.11 Plate 
Variation view).

Samples were not diluted. Rerun from sample 
dilution step.

NOTE:  Extreme outliers 
can be discovered in 
different views (Plate 
Variation, Assay QC, 
Heat map).  
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20. Revision history
Version Software 

version

Date Description

v2.2 2.2 2025-11-07 6.2 Install software: Updated the installation process. 
8.4 Intensity normalization (Olink® Target 96): Added new information. 
8.5 CV calculation: Added new section. 
8.8 Run QC: Added new information. 
8.9 QC criteria: Added new section. 
10.3 Sample Manifest file: Added new information about the Sample Manifest file. 
11.2 Import Panel Data Files or Panel Data Archive: Updated content and images. 
11.3 Create a new project: Updated content and images. 
11.4 Import a split Olink® Target 48 in version 2.x: Added new section. 
11.6 Migrate a project: Updated content and images. 
11.8 Perform quality control: Updated content and images. 
11.9 Export result files: Updated content and images. 
11.9.1 Preparing to Export the Analysis Report: Added new section. 
12.1 CSV files: Added new information. 
12.2 Analysis Report: Updated and expanded content. 
13. General: Updated content and images. 
14. Views: Updated content and images. 
15. Keyboard shortcuts: Added new section. 
16.1 Warning messages: Updated and added new information.
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